
Zadaci i rexeǌa - kvalifikacije 2024 - matematika
1. Koliko ima taqnih tvr�eǌa od slede�a tri?

P(A ∪B) = P(A) ∪ P(B)

(A \ C) ∩ (B \ C) = ∅ ⇒ A ∩B ⊆ C

(A∆B)∆B = A

Rexeǌe. Prva tvrdǌa nije taqna. Na primer, ako je A = {1}, a B = {2}, tada {1, 2} ∈ P(A ∪ B), dok
{1, 2} ̸∈ P(A) ∪ P(B).
Druga tvrdǌa jeste taqna. Pretpostavimo suprotno, tj. da postoji x ∈ A ∩ B, a x ̸∈ C. Tada x ∈ A i
x ∈ B, pa x ∈ (A \ C) ∩ (B \ C) = ∅. Kontradikcija!
Tre�a tvrdǌa je taqna. Poznato je da je simetriqna razlika asocijativna operacija, pa je (A∆B)∆B =
A∆(B∆B) = A∆∅ = A.

2. Neka su A, B, C kolinearne taqke takve da je
−→
AC = 3

−−→
BC. Data je taqka O van prave na kojoj se nalaze

taqke A, B i C. Poznato je da se
−−→
OC mo�e zapisati kao linearna kombinacija vektora

−→
OA i

−−→
OB, tj. u

obliku −−→
OC = α

−→
OA+ β

−−→
OB.

Na�i α− β.

Rexeǌe. Uslov se mo�e zapisati kao
−−→
OB =

1

3

−→
OA+

2

3

−−→
OC. Odavde je

−−→
OC = −1

2

−→
OA+

3

2

−−→
OB.

3. Dat je trougao ABC povrxine P . Neka su taqke A1, B1 i C1 takve da va�i
−−→
CA1 = 2

−→
AC,

−−→
BC1 =

−−→
CB i

−−→
AB1 = 3

−−→
BA.

Tada je povrxina △A1B1C1 jednaka?
Rexeǌe. Sa PΦ oznaqavamo povrxinu figure Φ. Prvo, primetimo da je PABC1

= PABC = P , poxto za ta
dva trougla va�i da imaju jednake visine iz temena A, kao i BC = BC1. Sliqno, PC1B1A = 3PC1BA = 3P ,
PCAB1 = 3PABC = 3P , PB1CA1 = 2PB1AC = 6P , PBCA1 = 2PBCA = 2P i PBC1A1 = PBCA1 = 2P . Ukupno, ovo
daje

PA1B1C1
= P + P + 3P + 3P + 6P + 2P + 2P = 18P.

Komentar. Zadatak se mogao rexiti i primenom trigonometrije ili vektorskog proizvoda.

4. Znaju�i da je x = 5 jedno od rexeǌa jednaqine (x+ 1)
4−34(x+ 1)

2−72 = 0, koji od dole navedenih brojeva
je tako�e rexeǌe ove jednaqine?

A) 13 B) 9 V) −5 G) −7 N) ne znam.

Rexeǌe. Poxto je x = 5 jedno od rexeǌa date jednaqine, to je (5 + 1)4 − 34 · (5 + 1)2 − 72 = 0. Jasno, tada
je i (−7 + 1)4 − 34 · (−7 + 1)2 − 72 = 0.

5. Za polinom P (x) va�i P (x+20) = 23−2x+2P (23) za svako x. Koliko iznosi zbir koeficijenata polinoma
P?



Rexeǌe. Zbir koeficijenata polinoma je, zapravo, vrednost P (1). Primetimo da zamenom x = 3 u datu
jednakost dobijamo P (23) = −17. Sada zamenom x = −19 imamo P (1) = 23− 2 · (−19) + 2 · (−17) = 27.

6. Ako je f funkcija takva da je f(1) = 2 i f(n+ 1) =
3f(n) + 1

3
za sve n ∈ N, odrediti vrednost f(2024).

Rexeǌe. Izraqunavaǌem f(1), f(2) i f(3) naslu�ujemo da je f(n) =
n+ 5

3
. Doka�imo to principom matem-

atiqke indukcije. Za n = 1 je tvr�eǌe taqno jer je f(1) = 2. Pretpostavimo da formula va�i za neki

n ∈ N, tj. da je f(n) =
n+ 5

3
za neki prirodan broj n. Poka�imo da je formula taqna i za n+ 1. Imamo

f(n+ 1) =
3f(n) + 1

3
=

3 · n+5
3 + 1

3
=

n+ 6

3
=

(n+ 1) + 5

3
,

qime smo zavrxili indukciju. Sada lako raqunamo f(2023) = 676.

7. Rexiti jednaqinu u skupu prirodnih brojeva

2x = x32.

Rexeǌe. Poxto rexavamo u skupu celih brojeva, kako je broj 2 jedini prost delilac broja 2x, to mora
i broja x32, pa x = 2k za neko k ∈ N. Prema tome, treba da reximo jednaqinu

22
k

= (2k)32,

xto daje 2k = 32k, a ova jednaqina ima jedno rexeǌe u skupu prirodnih brojeva, k = 8 (indukcijom se
lako pokazuje da za k ⩾ 9 va�i 2k ⩾ 32k). Dakle, x = 256 je jedino rexeǌe polazne jednaqine u skupu
prirodnih brojeva.

8. Odrediti vrednost broja n ∈ N za koji va�i

i+ 2i2 + 3i3 + . . .+ nin = 2024 + 2025i,

gde je i imaginarna jedinica.
Rexeǌe. Oznaqimo izraz na levoj strani sa L. Koriste�i osnovna svojstva stepenovaǌa imaginarne
jedinice, dobijamo

Re(L) = −2 + 4− 6 + 8− 10 + . . . , kao i Im(L) = 1− 3 + 5− 7 + . . . .

Ako bi realan deo imao neparan broj qlanova, taj broj bi bio negativan. Stoga, realan deo mora imati
paran broj qlanova pa ih mo�emo grupisati na slede�i naqin (−2 + 4) + (−6 + 8) + . . . . Poxto je zbir
u svakoj zagradi jednak 2, to nam ih treba 1011 i posledǌi broj koji koristimo je 4048. Prema tome,
n = 4048 ili n = 4049. Kako je za n = 4048 imaginarni deo jednak (1−3)+(5−7)+ . . .+(4045−4047) = −2024,
a za n = 4049 je Im(L) = −2024 + 4049 = 2025, to je n = 4049 jedino rexeǌe jednaqine.

9. Na slici ispod je prikazan deo grafika parabole qija je jednaqina y = ax2 + bx+ c.

Koji od slede�ih brojeva je pozitivan?

A) bc B) c V) ac G) ab N) ne znam.

Rexeǌe. Oznaqimo f(x) = ax2 + bx + c. Jasno, c = f(0) < 0 i a > 0. Lako vidimo da je 0 < xT =
−b

2a
, pa je

b < 0. Stoga, broj bc je pozitivan.

10. Oznaqimo α = log 2, β = log 3 i γ = log 7. Koji od slede�ih brojeva je najbli�i nekom celom broju?
Napomena: log x = log10 x za x > 0.

A) 2β B) 5α+ β V) α+ 2γ G) 2α+ β + γ N) ne znam.

Rexeǌe. Lako raqunamo 2β = log 9, 5α+β = log 32+ log 3 = log 96 = 1+ log 9.6, α+2γ = log 2+ log 49 = log 98 =
1 + log 9.8 i 2α+ β + γ = log 4 + log 3 + log 7 = log 84 = 1 + log 8.4.



11. Na�i vrednost izraza

A = sin2(1◦) + sin2(2◦) + sin2(3◦) + . . .+ sin2(89◦) + sin2(90◦)

Rexeǌe. Jasno, sin2(1◦) = cos2(89◦), sin2(2◦) = cos2(88◦), ..., pa je sin2(1◦)+sin2(89◦) = 1, sin2(2◦)+sin2(88◦) = 1,
..., xto daje

A = 44 + sin2 45◦ + sin2 90◦ = 45
1

2
.

12. Slika ispod prikazuje jediniqnu kru�nicu. Na kom od obele�enih lukova va�i

tg x < cosx < sinx?

Rexeǌe. Zapisivaǌem tg x =
sinx

cosx
dobijamo

sinx

cosx
< cosx < sinx. Da bi sve nejednakosti va�ile, sinx mora

biti pozitivan, jer bi u suprotnom i cosx bio negativan, ali tada bi tg x bio pozitivan kao koliqnik
dva negativna broja. Ovo iskǉuquje lukove D i E. Ako bi va�ilo 0 < cosx < sinx, tada bi bilo

cosx <
sinx

cosx
= tg x, xto ne �elimo. Dakle, cosx < 0, pa je jedini luk koji zadovoǉava oznaqen slovom C.

Lako se vidi da na tom luku va�e sve nejednakosti.

13. Ako su a⃗ i b⃗ vektori takvi da je |⃗a| = 2, ∢(⃗a, b⃗) = 60◦ i a⃗ ◦ (2a⃗− b⃗) = 6, onda je |⃗b| = ?
Rexeǌe. Primenom distributivnosti skalarnog proizvoda imamo

a⃗ ◦ (2a⃗− b⃗) = 2 · (⃗a ◦ a⃗)− a⃗ ◦ b⃗ = 2 · |⃗a|2 − |⃗a| · |⃗b| · cos∢(⃗a, b⃗) = 8− |⃗b|,

odakle je |⃗b| = 2.

14. Koliko postoji prostih brojeva p takvih da su brojevi 4p+ 1 i 2p2 + 1 tako�e prosti brojevi?
Rexeǌe. Ako je p ̸= 3, to p2 ≡ 1 (mod 3), pa 2p2+1 ≡ 0 (mod 3) i 2p2+1 > 3, pa je taj broj slo�en. Za p = 3
imamo 4 · 3 + 1 = 13 i 2 · 32 + 1 = 19, xto ostavǉa p = 3 kao jedino rexeǌe zadatka.

15. Ako je obim kvadrata na slici jednak 4, tada je obim jednakostraniqnog trougla jednak?

Rexeǌe. Oznaqimo taqke kao na slici. Poxto je stranica kvadrata jednaka 1, to je FA =
2√
3
, pa je

AD =
1√
3
i AB = 1 +

1√
3
. Obim jednakostraniqnog trougla je 3 +

√
3.



16. Kvadrat ABCD ima stranicu du�ine 1. Neka je taqka X na du�i AB, a taqka Y na du�i AD tako da je
∢CXY = 90◦. Odrediti vrednost najmaǌe mogu�e povrxine trougla CDY .
Rexeǌe. Neka je x = |AX|, a y = |AY |. Trouglovi AXY i BCX su sliqni: oba su pravougla, a i
∢AXY = ∢BCX jer se radi o uglovima s normalnim kracima. Zato va�i

|BC|
|BX|

=
|AX|
|AY |

, tj.
1

1− x
=

x

y
.

Odavde je y = x(1− x) = x− x2. Sada mo�emo povrxinu trougla CDY izraziti kao funkciju od x:

P (CDY ) =
1

2

(
x2 − x+ 1

)
.

Prema tome, potrebno je odrediti x ∈ [0, 1] za koje funkcija P (x) =
1

2
(x2 − x + 1) ima najmaǌu mogu�u

vrednost. Vidimo da je P (x) kvadratna funkcija s pozitivnim vode�im koeficijentom i temenom u taqki

x =
1

2
. Odavde zakǉuqujemo da se najmaǌa mogu�a povrxina dosti�e za x =

1

2
, odnosno u situaciji kada

je X sredixte du�i AB. Povrxina je tada
3

8
.

17. Brojeve od 1 do 17 treba pore�ati u niz tako da zbir svaka dva susedna broja u nizu bude potpun kvadrat.
Koji broj �e se na�i na 9. mestu u tom nizu?
Rexeǌe. Po�imo od broja 17. Jedini broj sa kojim on u zbiru daje potpun kvadrat je 8, pa 17 mora
biti ili na poqetku ili na kraju niza. Neka je, bez umaǌeǌa opxtosti, na poqetku niza. Trenutno niz
izgleda [17, 8]. Iza broja 8 mo�e jedino biti broj 1. Sliqnim postupkom, dobijamo da su jedini nizovi
koji ispuǌavaju uslove zadatka

[17, 8, 1, 15, 10, 6, 3, 13, 12, 4, 5, 11, 14, 2, 7, 9, 16],

kao i isti taj niz u obrnutom redosledu. Deveti qlan oba niza je broj 12.

18. Postoje dve vrednosti za r > 0 takve da krug (x− 2)2 + (y − 1)2 = r2 dodiruje krug (x+ 2)2 + (y + 2)2 = 49.
Apsolutna vrednost razlike tih vrednosti je?
Rexeǌe. Neka su dati krugovi k1 : (x−x1)

2+(y−y1)
2 = r21 sa centrom u O1(x1, y1) i k2 : (x−x2)

2+(y−y2)
2 = r22

sa centrom u O2(x2, y2). Krugovi se dodiruju ako i samo ako va�i O1O2 = r1 + r2 (spoǉa se dodiruju) ili
O1O2 = |r1 − r2| (krugovi se dodiruju iznutra). Imamo da je rastojaǌe taqke (2, 1) od (−2,−2) jednako√

(2− (−2))2 + (1− (−2))2 = 5, r1 = r i r2 = 7. Poxto je 7 + r > 5, nije mogu�e da se krugovi dodiruju
spoǉa, pa treba razmotriti rexeǌa jednaqine |r−7| = 5. Ova jednaqina ima dva rexeǌa: 2 i 12. Odgovor
je |2− 12| = 10.

19. Neka je K = {a, b, c} troqlani podskup skupa S = {1, 2, 3, . . . , 10000} takav da va�i

b =
a+ c

2
.



Koliko razliqitih podskupova K skupa S postoji?
Rexeǌe. Zapravo, zadatak je da prona�emo broj naqina da odaberemo brojeve a i c takve da je a+ c paran
(tada �e b biti jednoznaqno odre�en i pripada�e skupu S), pri qemu redosled brojeva a i c nije bitan

(jer je req o podskupovima). Od 5000 parnih brojeva, dva razliqita mo�emo odabrati na
5000 · 4999

2

naqina. Sliqno, od 5000 neparnih brojeva, dva razliqita mo�emo odabrati na
5000 · 4999

2
naqina. Ovo

ukupno daje 5000 · 4999 naqina.

20. Neka su E, F , G i H sredixta stranica AB, BC, CD i DA, redom, konveksnog qetvorougla ABCD, a I
presek du�i EG i FH. Ako su povrxine qetvorouglova AEIH, BFIE i CGIF jednake 8, 16 i 20, redom,
kolika je povrxina qetvorougla DHIG?
Rexeǌe. Na slici su prikazani istom bojom trouglovi istih povrxina (jer su odgovaraju�e visine
jednake i poxto su E, F , G i H sredixta stranica). Sa PΦ oznaqavamo povrxinu figure Φ. Lako se
vidi da va�i PAEIH + PCGIF = PBFIE + PDHIG, odakle imamo PDHIG = 12.
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Question 1
Not answered

Marked out of 3

v1 (latest)

Колико има тачних тврдњи од следећа три?

Са  означавамо партитивни скуп скупа , а са  симетричну разлику скупова  и .

a. 2

b. 1

c. 0

d. 3

P(A ∪ B) = P(A) ∪ P(B)

(A ∖ C) ∩ (B ∖ C) = ∅ ⇒ A ∩ B ⊆ C

(AΔB)ΔB = A

P(X) X AΔB A B

Your answer is incorrect.

The correct answer is: 2

11/20/24, 4:57 PM Тест: Attempt review | Moodle

https://lms.matf.bg.ac.rs/moodle/mod/quiz/review.php?attempt=270&cmid=11 1/20



Question 2
Not answered

Marked out of 3

v1 (latest)

Question 3
Not answered

Marked out of 3

v1 (latest)

Нека су , ,  колинеарне тачке такве да је . Дата је тачка  ван праве на којој се налазе тачке ,  и . Познато је да

се  може записати као линеарна комбинација вектора  и , тј. у облику

Одредити .

a.

b.

c.

d.

A B C = 3AC
−→−

BC
−→−

O A B C

OC
−→−

OA
−→−

OB
−→−

= α + β .OC
−→−

OA
−→−

OB
−→−

α − β

2

−1

1

−2

Your answer is incorrect.

The correct answer is: −2

Дат је троугао  површине . Нека су тачке ,  и  такве да важи
   

    Тада је површина  једнака?

a.

b.

c.

d.

ABC P A1 B1 C1

= 2 , = и = 3 .CA1

− →−
AC
−→−

BC1

− →−
CB
−→−

AB1

− →−
BA
−→−

△A1B1C1

22P

16P

17P

18P

Your answer is incorrect.

The correct answer is: 18P

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 4
Not answered

Marked out of 3

v1 (latest)

Question 5
Not answered

Marked out of 3

v2 (latest)

Знајући да је  једно од решења једначине 

који од доле наведених бројева је такође решење ове једначине?

a.

b.

c.

d.

x = 5

− 34 − 72 = 0,(x + 1)4 (x + 1)2

−7

−5

4

−6

Your answer is incorrect.

The correct answer is: −7

За полином  важи  за свако . Колико износи збир коефицијената полинома ?

a.

b.

c.

d.

P (x) P (x + 20) = 23 − 2x + 2P (23) x P

23

24

25

27

Your answer is incorrect.

The correct answer is: 27

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 6
Not answered

Marked out of 3

v1 (latest)

Question 7
Not answered

Marked out of 3

v1 (latest)

Ако је  функција таква да је  и  за све , одредити вредност .

a.

b.

c.

d.

f f(1) = 2 f(n + 1) =
3f(n) + 1

3
n ∈ N f(2024)

2025

2024

676

677

Your answer is incorrect.

The correct answer is: 676

Једначина

има тачно једно решење у скупу природних бројева и то решење је

a.

b.

c.

d.

= .2x x32

x = 128

x = 1024

x = 256

x = 512

Your answer is incorrect.

The correct answer is: x = 256

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 8
Not answered

Marked out of 3

v1 (latest)

Question 9
Not answered

Marked out of 3

v1 (latest)

Одредити вредност броја  за који важи

где је  имагинарна јединица.

a.

b.

c.

d.

n ∈ N

i + 2 + 3 + … + n = 2024 + 2025i,i2 i3 in

i

n = 4048

n = 2024

n = 2025

n = 4049

Your answer is incorrect.

The correct answer is: n = 4049

На слици испод је приказан део графика параболе чија је једначина .

Који од понуђених бројева је позитиван?

a.

b.

c.

d.

y = a + bx + cx2

ac

ab

bc

c

Your answer is incorrect.

The correct answer is: bc

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 10
Not answered

Marked out of 3

v1 (latest)

Question 11
Not answered

Marked out of 3

v2 (latest)

Означимо ,  и . Који од следећих бројева је најближи неком целом броју? Напомена:  за
.

a.

b.

c.

d.

α = log 2 β = log 3 γ = log 7 log x = xlog10

x > 0

α + 2γ

2β

2α + β + γ

5α + β

Your answer is incorrect.

The correct answer is: α + 2γ

Одредити вредност израза

a.

b.

c.

d.

A = ( ) + ( ) + ( ) + … + ( ) + ( ).sin2 1∘ sin2 2∘ sin2 3∘ sin2 89∘ sin2 90∘

45

89

45.5

44.5

Your answer is incorrect.

The correct answer is: 45.5

11/20/24, 4:57 PM Тест: Attempt review | Moodle

https://lms.matf.bg.ac.rs/moodle/mod/quiz/review.php?attempt=270&cmid=11 6/20



Question 12
Not answered

Marked out of 3

v2 (latest)

Question 13
Not answered

Marked out of 3

v1 (latest)

Слика испод приказује јединичну кружницу.

На ком од обележених лукова важи

(Са  смо означили тангенс угла .)

a.

b.

c.

d.

tan x < cos x < sin x?

tan x x

A

B

C

D

Your answer is incorrect.

The correct answer is: C

Ако су  и  вектори такви да је ,  и , онда је 

a.

b.

c.

d.

a⃗  b ⃗  | | = 2a⃗  ∢( , ) =a⃗  b ⃗  60∘ ∘ (2 − ) = 6a⃗  a⃗  b ⃗  | | = ?b ⃗ 

6

4

8

2

Your answer is incorrect.

The correct answer is: 2

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 14
Not answered

Marked out of 3

v1 (latest)

Question 15
Not answered

Marked out of 3

v1 (latest)

Колико постоји простих бројева  таквих да су бројеви  и  такође прости бројеви?

a. бесконачно много

b. ниједан

c. 2

d. 1

p 4p + 1 2 + 1p2

Your answer is incorrect.

The correct answer is: 1

Ако је обим квадрата на слици једнак , тада је обим једнакостраничног троугла једнак:

a.

b.

c.

d.

4

1 + 3
–√

3 +
3
–√

3

3 + 3
–√

1 +
3
–√

3

Your answer is incorrect.

The correct answer is: 3 + 3–√

11/20/24, 4:57 PM Тест: Attempt review | Moodle
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Question 16
Not answered

Marked out of 3

v2 (latest)

Question 17
Not answered

Marked out of 3

v2 (latest)

Квадрат  има страницу дужине . Нека је тачка  на дужи , а тачка  на дужи  тако да је . Одредити
вредност најмање могуће површине троугла .

a.

b.

c.

d.

ABCD 1 X AB Y AD ∢CXY = 90∘

CDY

1

4

1

8

3

8

1

2

Your answer is incorrect.

The correct answer is: 
3

8

Бројеве од  до  треба поређати у низ тако да збир свака два суседна броја у низу буде потпун квадрат. Који број ће се наћи на 9.
месту у том низу (за први члан у низу сматрамо да је на позицији 1)?

a.

b.

c.

d.

1 17

17

12

9

1

Your answer is incorrect.

The correct answer is: 12
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Question 18
Not answered

Marked out of 3

v1 (latest)

Question 19
Not answered

Marked out of 3

v1 (latest)

Постоје две вредности за  такве да круг  додирује круг . Апсолутна вредност
разлике тих вредности је?

a.

b.

c.

d.

r > 0 (x − 2 + (y − 1 =)2 )2 r2 (x + 2 + (y + 2 = 49)2 )2

12

14

8

10

Your answer is incorrect.

The correct answer is: 10

Нека је  трочлани подскуп скупа  такав да важи

Колико различитих подскупова  скупа  постоји?

a.

b.

c.

d.

K = {a, b, c} S = {1, 2, 3, … , 1000}

b = .
a + c

2

K S

1000 ⋅ 500

500 ⋅ 499

250 ⋅ 499

500 ⋅ 500

Your answer is incorrect.

The correct answer is: 500 ⋅ 499
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Question 20
Not answered

Marked out of 3

v1 (latest)

Question 21
Not answered

Marked out of 3

v1 (latest)

Question 22
Not answered

Marked out of 3

v1 (latest)

Нека су , ,  и  средишта страница , ,  и , редом, конвексног четвороугла , а  пресек дужи  и .
Ако су површине четвороуглова ,  и  једнаке ,  и , редом, колика је површина четвороугла ?

a.

b.

c.

d.

E F G H AB BC CD DA ABCD I EG FH

AEIH BFIE CGIF 8 16 20 DHIG

28

12

10

40

Your answer is incorrect.

The correct answer is: 12

Која од следећих опција је пример IP адресе:

a. 192.168.1.1

b. http://www.google.com

c. Facebook

d. www.example.com

Your answer is incorrect.

The correct answer is: 192.168.1.1

Код који има 256 знакова, што је постигнуто са 8 битова и који омогућава чување слова, цифара, специјалних знакова и „невидљивих
карактера” назива се:

a. Unicode

b. ASCII

c. Extended ASCII

d. Морзеов код

Your answer is incorrect.

The correct answer is: Extended ASCII
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Question 23
Not answered

Marked out of 3

v1 (latest)

Question 24
Not answered

Marked out of 3

v1 (latest)

Question 25
Not answered

Marked out of 3

v1 (latest)

Када ALU заврши операцију, резултат се најчешће:

a. складишти у одговарајућем регистру

b. пребацује у RAM

c. складишти у кеш меморији

d. преноси на улазно-излазни уређај

Your answer is incorrect.

The correct answer is: складишти у одговарајућем регистру

За време потребно да се приступи различитим типовима меморија у рачунарском важи:

a. хард диск  кеш меморија  радна меморија  регистри процесора

b. регистри процесора  кеш меморија  радна меморија  хард диск

c. радна меморија  регистри процесора  кеш меморија  хард диск

d. кеш меморија  регистри процесора  радна меморија  хард диск

< < <

< < <

< < <

< < <

Your answer is incorrect.

The correct answer is: регистри процесора  кеш меморија  радна меморија  хард диск< < <

Која од следећих магистрала није серијска:

a. PCI-E

b. USB

c. SATA

d. PCI

Your answer is incorrect.

The correct answer is: PCI
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Question 26
Not answered

Marked out of 3

v3 (latest)

Question 27
Not answered

Marked out of 3

v1 (latest)

Која формула у програму Excel сабира вредности у ћелијама од  до ?

a.
=SUM(A1:A5)

b.
=ADD(A1:A5)

c.
=TOTAL(A1:A5)

d. ништа од претходно понуђеног

A1 A5

Your answer is incorrect.

The correct answer is:

=SUM(A1:A5)

Како се убацује број странице у документ у Word-у?

a. Insert -> Page Number

b. Insert -> Footer

c. Format -> Page Setup

d. View -> Page Layout

Your answer is incorrect.

The correct answer is: Insert -> Page Number
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Question 28
Not answered

Marked out of 3

v1 (latest)

Question 29
Not answered

Marked out of 3

v1 (latest)

Одредити ред сложености наредног кода (Напомена: вредност бројача i се увећава за 1 у итерацији for петље)

k = 1
p = 1
while k < n do
    for i = k to 3 * k - 1 do
        p = p * a[i]
    k = k * 3

a.

b.

c.

d.

O(log n)

O(1)

O(n)

O(n log n)

Your answer is incorrect.

The correct answer is: O(n)

Која структура ради по принципу FIFO (енгл. first in, first out):

a. ред

b. стек

c. низ

d. мапа

Your answer is incorrect.

The correct answer is: ред
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Question 30
Not answered

Marked out of 3

v1 (latest)

Question 31
Not answered

Marked out of 3

v1 (latest)

Question 32
Not answered

Marked out of 3

v1 (latest)

У структуру података стек се додају бројеви , , ,  и , редом. Након тога се из стека избаце два елемента. Тада важи:

a. на дну стека налази се број , а на врху 

b. на дну стека налази се број , а на врху 

c. на дну стека налази се број , а на врху 

d. на дну стека налази се број , а на врху 

1 2 3 4 5

1 3

3 1

5 3

3 5

Your answer is incorrect.

The correct answer is: на дну стека налази се број , а на врху 1 3

Сложеност приступа произвољном елементу у једноструко повезаној листи дужине  је:

a.

b.

c.

d.

n

O(1)

O(n)

O(log n)

O(n log n)

Your answer is incorrect.

The correct answer is: O(n)

Која SQL команда се користи за брисање табеле?

a. CLEAR TABLE

b. REMOVE TABLE

c. DELETE TABLE

d. DROP TABLE

Your answer is incorrect.

The correct answer is: DROP TABLE
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Question 33
Not answered

Marked out of 3

v1 (latest)

Question 34
Not answered

Marked out of 3

v1 (latest)

У бази података која чува податке о ученицима средњих школа налазе се две табеле:  (примарни кључ)
 и  (примарни кључ) . У табели  налазе се следећи редови:

Која од следећих тврдњи је тачна?

a.  ће се успешно извршити.

b.  ће се успешно извршити.

c. колона  у табели  представља страни кључ

d. све претходне тврдње су нетачне

Ucenik(id ucenika

, ime, prezime, id skole) Skola(id , naziv, grad) Skola

{101, Prva beogradska gimnazija, Beograd}

{202, Gimnazija, Svilajnac}

{303, Medicinska skola, Nis}

INSERT INTO Ucenik VALUES (1, 'Nikola', 'Petrovic', 102)

INSERT INTO Skola VALUES (202, 'Nikola Tesla', 'Beograd')

id Skola

Your answer is incorrect.

The correct answer is: све претходне тврдње су нетачне

Означити израз који је еквивалентан изразу 

(Са  означавамо ексклузивну дисјункцију тј. XOR)

a.

b.

c.

d.

A ∧ (B ⊕ C)

⊕

(A ∧ B ∧ ¬C) ∨ (A ∧ ¬B ∧ C)

A ∧ (B ∧ ¬C) ∨ (¬A ∧ C)

A ∧ (¬B ∨ C) ∧ (B ∨ ¬C)

(A ∧ ¬B) ∨ (A ∧ ¬C)

Your answer is incorrect.

The correct answer is: (A ∧ B ∧ ¬C) ∨ (A ∧ ¬B ∧ C)
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Question 35
Not answered

Marked out of 3

v1 (latest)

Question 36
Not answered

Marked out of 3

v1 (latest)

Question 37
Not answered

Marked out of 3

v1 (latest)

Ако је  декaдни запис броја  који је записан у систему са основном , тада је вредност декадног броја  у систему са основном
:

a.

b.

c.

d.

X 121 3 33
X

33

41

21

16

Your answer is incorrect.

The correct answer is: 21

Уз претпоставку да немамо ограничење за величину записа, битовским шифтовaњем улево неозначеног броја  за  места (где је 
природан број), тј. изразом , добија се број који је:

a.  пута мањи од броја 

b.  пута већи од броја 

c.  пута већи од броја 

d.  пута мањи од броја 

X n n

X << n

2n X

n X

2n X

n X

Your answer is incorrect.

The correct answer is:  пута већи од броја 2n X

Број  је записан у бинарном систему. Његов еквивалент у декадном је:

a.

b.

c.

d.

10110101

173

181

197

189

Your answer is incorrect.

The correct answer is: 181
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Question 38
Not answered

Marked out of 3

v2 (latest)

Покретање наредног програма ће исписати

x = 2
y = 3
x = x + y
y = x - y
x = x - y
print(y)

a. 6

b. 3

c. 2

d. 0

Your answer is incorrect.

The correct answer is: 2
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Question 39
Not answered

Marked out of 3

v1 (latest)

Шта би се исписало покретањем наредног програма?

x = 7
y = 5

if x > y then
    x = x - y
else
    y = y - x

if x == y then
    print(x * 2)
else if x > y then
    print(x + y)
else
    print(y - x)

a. 3

b. 14

c. 4

d. 10

Your answer is incorrect.

The correct answer is: 3
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Question 40
Not answered

Marked out of 3

v1 (latest)

Колико пута ће бити исписана реч Hello (дат је псеудокод)?

i = -1
while i <= 20:
    if i mod 4 == 0:
        i = i + 1
        continue (skip this iteration)
    if i mod 3 == 0:
        print "Hello"
    i = i + 1

a. 5

b. 7

c. 6

d. 8

Your answer is incorrect.

The correct answer is: 5
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